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Copyrights 

© Cypress Semiconductor Corporation, 2016. This document is the property of Cypress Semiconductor Corporation and its 
subsidiaries, including Spansion LLC (“Cypress”).  This document, including any software or firmware included or referenced 
in this document (“Software”), is owned by Cypress under the intellectual property laws and treaties of the United States and 
other countries worldwide.  Cypress reserves all rights under such laws and treaties and does not, except as specifically 
stated in this paragraph, grant any license under its patents, copyrights, trademarks, or other intellectual property rights.  If 
the Software is not accompanied by a license agreement and you do not otherwise have a written agreement with Cypress 
governing the use of the Software, then Cypress hereby grants you a personal, non-exclusive, nontransferable license 
(without the right to sublicense) (1) under its copyright rights in the Software (a) for Software provided in source code form, 
to modify and reproduce the Software solely for use with Cypress hardware products, only internally within your organization, 
and (b) to distribute the Software in binary code form externally to end users (either directly or indirectly through resellers and 
distributors), solely for use on Cypress hardware product units, and (2) under those claims of Cypress’s patents that are 
infringed by the Software (as provided by Cypress, unmodified) to make, use, distribute, and import the Software solely for 
use with Cypress hardware products.  Any other use, reproduction, modification, translation, or compilation of the Software is 
prohibited. 

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, WITH REGARD TO THIS DOCUMENT OR ANY SOFTWARE OR ACCOMPANYING HARDWARE, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. To the extent permitted by applicable law, Cypress reserves the right to make changes to this document without 
further notice. Cypress does not assume any liability arising out of the application or use of any product or circuit described 
in this document.  Any information provided in this document, including any sample design information or programming code, 
is provided only for reference purposes.  It is the responsibility of the user of this document to properly design, program, and 
test the functionality and safety of any application made of this information and any resulting product.  Cypress products are 
not designed, intended, or authorized for use as critical components in systems designed or intended for the operation of 
weapons, weapons systems, nuclear installations, life-support devices or systems, other medical devices or systems 
(including resuscitation equipment and surgical implants), pollution control or hazardous substances management, or other 
uses where the failure of the device or system could cause personal injury, death, or property damage (“Unintended Uses”).  
A critical component is any component of a device or system whose failure to perform can be reasonably expected to cause 
the failure of the device or system, or to affect its safety or effectiveness.  Cypress is not liable, in whole or in part, and you 
shall and hereby do release Cypress from any claim, damage, or other liability arising from or related to all Unintended Uses 
of Cypress products.  You shall indemnify and hold Cypress harmless from and against all claims, costs, damages, and other 
liabilities, including claims for personal injury or death, arising from or related to any Unintended Uses of Cypress products. 

Cypress, the Cypress logo, Spansion, the Spansion logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB,  
F-RAM, and Traveo are trademarks or registered trademarks of Cypress in the United States and other countries.  For a more 
complete list of Cypress trademarks, visit cypress.com.  Other names and brands may be claimed as property of their 
respective owners. 
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Safety Information 

  

The CY3676 Evaluation Kit is intended for use as an evaluation platform for hardware or software in a laboratory environment. 
The board is an open system design, which does not include a shielded enclosure, so the board may cause interference to 
other electrical or electronic devices in close proximity. In a domestic environment, this product may cause radio interference. 
In such cases, the user may be required to take adequate preventive measures. Also, this board should not be used near any 
medical equipment or RF devices. 

Attaching additional wiring to this product or modifying the product operation from the factory default may affect its 
performance and cause interference with other apparatus in the immediate vicinity. If such interference is detected, suitable 
mitigating measures should be taken. 

 

The CY3676 Evaluation Kit contains electrostatic discharge (ESD)-sensitive devices. Electrostatic 
charges readily accumulate on the human body and any equipment, and can discharge without detection. 
Permanent damage may occur on devices subjected to high-energy discharges. Proper ESD precautions 
are recommended to avoid performance degradation or loss of functionality. Store unused CY3676 
Evaluation Kit boards in the protective shipping package. 

 

General Safety Instructions 

ESD Protection  

ESD can damage boards and associated components. Cypress recommends that the user perform procedures only at an 
ESD workstation. If ESD workstation is not available, use appropriate ESD protection by wearing an antistatic wrist strap 
attached to the chassis ground (any unpainted metal surface) on the board when handling parts. 

Handling Boards 

CY3676 Evaluation Kit is sensitive to ESD. Hold the board only by its edges. After removing the board from its box, place it 
on a grounded, static free surface. Use a conductive foam pad if available. Do not slide board over any surface. 

Certification Disclaimer  

This kit is intended for demonstration, evaluation or development purposes only and is not considered by Cypress 
Semiconductor to be a finished end-product fit for general consumer use. It generates and can radiate radio frequency energy 
and has not been specifically tested for CE certification compliance. Operation of this equipment in other environments may 
cause interference with radio communications, in which case the user at their own expense will be required to take whatever 
measures may be required to correct this interference. 
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1 Introduction 

  

Thank you for your interest in the CY3676 Evaluation Kit (EVK). The CY3676 EVK is designed to enable you to evaluate the 
programmable clock device CY29412, the latest addition to programmable devices in Cypress’s timing product portfolio. The 
CY29412 is a high performance programmable oscillator with one fractional PLL that generates any frequency up to 2.1 GHz 
with jitter as low as 110 fs. The device offers one differential output. The CY29412 comes in an 8-pin LCC package for 
industrial applications. The differential I/O standards supported are LVDS, LVPECL, High-Speed Current Steering Logic 
(HCSL) and Current Mode Logic (CML). The device also supports features like a Voltage-Controlled Crystal Oscillator 
(VCXO), and provides the user with an I2C programming interface.  

The CY3676 EVK allows you to evaluate both AC and DC parameters of the output signals by making required on-board 
termination settings. 

The CY3676 EVK is available through the Cypress Online Store or through our distributors. 

1.1 CY3676 EVK Contents 

The CY3676 EVK includes the following: 

 CY3676 Evaluation Board  

 USB Standard-A to Mini-B cable 

 Quick Start Guide 

Figure 1-1. CY3676 Kit Contents 

 
 

Inspect the contents of the kit. If you find any part missing, contact your nearest Cypress sales office for assistance: 
www.cypress.com/support. 

 

http://www.cypress.com/cypress-store
http://www.cypress.com/support
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1.2 Getting Started 

To learn the solution quickly and apply it to your design, refer to the CY3676 Quick Start Guide inside the kit box or in the 
Installation directory. The default location for the kit documents is: 

<Install_Directory>\CY3676 Evaluation Kit\<version>\Documentation   

This guide will help you get acquainted with the CY3676 EVK: 

The Software Installation chapter describes the installation of the kit software.  

The Kit Operation chapter describes the major features of CY3676 Evaluation Kit. 

The Hardware chapter describes the hardware content of the CY3676 Evaluation Kit and the hardware operation.  

The Example Projects chapter describes the multiple projects that will help you understand how to evaluate different 
supported output standards on this kit.  

The Appendix captures DC/AC Measurements of Clock Outputs, Schematics, Fab Drawing, and the bill of materials (BOM). 

1.3 Additional Learning Resources 

Visit www.cypress.com/CY3676 and www.cypress.com/HPO for additional learning resources including datasheets and 
application notes. 

1.4 Technical Support 

For assistance, go to: www.cypress.com/support, or contact our customer support at +1(800) 541-4736 Ext. 2 (in the USA), 
or +1 (408) 943-2600 Ext. 2 (International). 

1.5 Document Conventions 

Table 1-1. Document Conventions for Guides 

Convention Usage 

Courier New 
Displays file locations, user entered text, and source code: 

C:\ ...cd\icc\ 

Italics Displays file names and reference documentation. 

[Bracketed, Bold] 
Displays keyboard commands in procedures: 

[Enter] or [Ctrl] [C] 

File > Open 
Represents menu paths: 

File > Open > New Project 

Bold 
Displays commands, menu paths and icon names in procedures: 

Click the File icon and then click Open. 

Times New Roman 
Displays an equation: 

2 + 2 = 4 

Text in gray boxes Describes Cautions or unique functionality of the product. 

  

http://www.cypress.com/CY3676
http://www.cypress.com/HPO
http://www.cypress.com/support
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1.6 Acronyms 

Table 1-2. List of Acronyms used in this Document 

Acronym Definition 

BOM Bill of Materials 

CML Current Mode Logic 

DNP, DNM Do Not Populate, Do Not Mount 

HCSL High-Speed Current Steering Logic 

I2C Inter-Integrated Circuit 

JEDEC Joint Electron Device Engineering Council 

LDO Low-Dropout 

LVPECL Low Voltage Positive Emitter Coupled Logic 

LVPECL2 Low Voltage Positive Emitter Coupled Logic with zero Common-mode current 

LVDS Low Voltage Differential Signaling 

OE Output Enable 

SMA Subminiature Version A 

VCXO Voltage Controlled Crystal Oscillator 

OTP One-Time Programmable 
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2 Software Installation 

 

This chapter describes the steps to install the software tools and packages on a PC for using the CY3676 Evaluation Kit.  

2.1 Before You Begin 

All Cypress software installations require administrator privileges. Ensure that you have the required privileges on the system 
for successful installation. Before you install the kit software, close any other Cypress software that is currently running. 

2.2 Install Software 

Follow these steps to install the CY3676 Evaluation Kit software:  

1. Download the CY3676 Evaluation Kit software from www.cypress.com/CY3676. The software is available in the following 
formats: 

a. CY3676 Evaluation Kit Complete Setup: This installation package contains the files related to the CY3676 

Evaluation Kit. However, it does not include the Windows Installer or Microsoft .NET Framework packages. If these 
packages are not available on your computer, the installer directs you to download and install them from the Internet. 

b. CY3676 Evaluation Kit Only: This executable file installs only the CY3676 EVK contents, which include example 

projects, hardware files, and user documents. This package can be used if all the software prerequisites (listed in 
step 4) are installed on your PC. 

c. CY3676 Evaluation Kit ISO: This file is a complete package, stored in a CD/DVD-ROM image format that you can 

use to create a CD/DVD or extract using an ISO extraction program such as WinZip or WinRAR. The file can also 
be mounted similar to a virtual CD/DVD using virtual drive programs such as Virtual CloneDrive and MagicISO. This 
file includes all the required software, utilities, drivers, hardware files, and user documents. 

2. If you have downloaded the ISO file, mount it on a virtual drive. If you do not have a virtual drive to mount, extract the 
ISO contents using the appropriate ISO extractor (such as MagicISO or PowerISO). Double-click cyautorun.exe in the 
root directory of the extracted content or the mounted ISO if the “Autorun from CD/DVD” option is not enabled on the PC. 
The installation window will appear automatically.  

Note: If you are using the “Kit Complete Setup” or “Kit Only” file, then go to step 4 for installation. 

3. Click Install CY3676 EVK to start the installation as shown in Figure 2-1. 

  

http://www.cypress.com/CY3676
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Figure 2-1. Installer Screen 

 

 

4. Click Change… if you want to install the CY3676 EVK in a location other than the default, and then click Next as shown 

in Figure 2-2. 

Note: When you click Next, the CY3676 EVK installer automatically installs the required software, if it is not present on 

your computer. The pre-requisites are ClockWizard 2.1 and PSoC Programmer 3.25.0 or later. 

Figure 2-2. InstallShield Wizard 
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5. Select the Installation Type (see Figure 2-3). The drop-down menu contains three options: Typical (installs all the 
required features), Custom (lets you choose the features to be installed), and Complete (installs all the contents). Click 
Next after you select the Installation Type. 

       Note: It is recommended that you choose the Typical Installation Type. 

Figure 2-3. Product Installation Overview 

 
 

6. Read and accept the End-User License Agreement, and then click Next. 

When the installation begins, a list of packages appears on the Installation page. A green check mark appears next to 
each package after successful installation. 

7. Enter your contact information or select the Continue Without Contact Information check box. 

8. Click Finish to complete the CY3676 EVK installation.  

After the installation is complete, the kit contents are available in the following location:  

<Install_Directory>\CY3676 Evaluation Kit\<version>.   

Default location: 

Windows 7 (64-bit): C:\Program Files (x86)\Cypress\CY3676 Evaluation Kit  

Windows 7 (32-bit): C:\Program Files\Cypress\CY3676 Evaluation Kit  
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2.3 Install Hardware 

No additional hardware installation is required for this kit. 

2.4 Uninstall Software 

You can uninstall the software using one of the following methods: 

 Go to Start > All Programs > Cypress > Cypress Update Manager > Cypress Update Manager, and select the 
specific software package. Click the Uninstall button. 

 Go to Start > Control Panel > Programs and Features, and select the specific software package. Click the 
Uninstall/Change button. 
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3 Kit Operation 

 

The CY3676 EVK can be used to evaluate the CY29412, a high performance programmable oscillator. Connect the CY3676 
kit through a USB cable to a PC running Cypress’s ClockWizard 2.1 software. The clock device CY29412 can be configured 
and programmed to generate frequencies with best-in-class performance. 

3.1 Theory of Operation 

The CY3676 EVK offers one differential clock output for evaluation. The CY29412 device is available with a crystal embedded 
inside the package. There is no requirement for an external clock source or on-board crystal for this kit.  

The kit is capable of generating fixed 3.3 V, 2.5 V, and 1.8 V voltages from a 5 V USB port. The on-board PSoC 5LP (U7) 
performs USB-to-I2C conversion. There is one power LED (LED2) driven from the 5 V USB supply and one status LED (LED1) 
controlled by the PSoC 5LP. The output of the LDO regulator (U8) is configurable (3.3 V, 2.5 V, or 1.8 V) through jumper J13.  

Note: An additional on-board LDO (U9 – not shown here) generates a fixed 3.3 V supply for the PSoC 5LP in the CY3676 
Rev ** EVK. This feature has been changed in CY3676 Rev *A EVK where the PSoC 5LP is directly powered by 5V USB 

supply. The CY3676 kit revision is printed on the label at the back of the kit box. 

Figure 3-1 illustrates the block diagram of the CY3676 EVK. 

Figure 3-1. CY3676 EVK Block Diagram 
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3.2 Functional Description 

The differential clock outputs (J6, J7) are driven out on to SMA connectors. The EVK is populated with 50  resistors (R30 
and R31) for output termination. The termination options of the differential outputs in the evaluation board are listed in the 
Hardware chapter. These termination circuits are designed to terminate the output clocks in LVPECL, LVDS, HCSL, 
LVPECL2, and CML signal types by populating, or by not populating the J5 jumper shunt. 

Figure 3-2 illustrates the top and bottom view of the CY3676 EVK. 

 Figure 3-2. CY3676 EVK (Top View, Bottom View)  

 

                   CY3676 EVK Top View           CY3676 EVK Bottom View 

3.3 CY3676 EVK USB Connection 

The clock device CY29412 on the kit is not loaded with any default configuration. To view and evaluate different configurations 
on an oscilloscope (or other standard instruments), the clock device must be programmed with the desired configuration. The 
ClockWizard 2.1 application is required for programming any configuration. Therefore, the kit should be connected  
(see Figure 3-3) to the PC through the USB connection for programming. 

Figure 3-3. Kit Connected through USB 
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The kit enumerates as a USB Composite Device as part of the Driver Software Installation on Windows. 

Figure 3-4. USB Driver Installation 

 

 

After the driver installation is complete, the device is ready to use. 

Figure 3-5. USB Driver Installation Complete 

 

 

3.4 Programming the CY29412 

The CY29412 device has internal one-time programmable (OTP) nonvolatile memory called eFuse. The device also contains 
volatile memory that stores an exact copy of the eFuse at the release of reset at power up. The output frequency depends on 
the configurations in the volatile memory. Writing the entire device configuration in the volatile memory section of a blank 
device after power up is called Functional Programming. The CY3676 kit is shipped with a blank CY29412 device. This kit 
can be used to check both the Functional and eFuse Programming of the device using ClockWizard 2.1. See Functional 
Programming of the CY29412 and eFuse Programming of the CY29412 for details. 

3.5 Functional Programming of the CY29412 

ClockWizard 2.1 is used for functional programming of the CY29412. A configuration created in ClockWizard 2.1 can be 
downloaded to the volatile memory section of the device.  

The example ClockWizard 2.1 projects can be found at the following location: 

<Install_Directory>\CY3676 Evaluation Kit\<version>\Firmware\Example Projects 

Configuration profiles generated from these projects can be used to evaluate the CY29412 device on the CY3676 EVK. Refer 
to Functional Programming for the kit’s hardware settings prior to programming. It is recommended that you copy the example 
projects to another location if you want to make any modifications to the settings so that the default project is retained in the 
installation directory. 

CAUTION 

Before programming the CY3676 EVK through ClockWizard 2.1, it is recommended to go through 
the Hardware section of this user guide. The mismatch between the hardware settings and the 
ClockWizard 2.1 configuration may cause potential damage of the EVK. Specifically, the voltage 
setting on the kit selected with J13 must match the voltage setting within the configuration to be 
programmed. 
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3.5.1 Generating and Programming the Device Configuration Profile 

The ClockWizard 2.1 is used to generate profiles and to perform functional programming of the device.   

1. Verify that the power supply voltage jumper is set for the voltage used in the project that you intend to program. See the 
Hardware section for details. 

2. Connect the CY3676 EVK to your PC through the supplied USB cable. 

3. To launch the ClockWizard 2.1 application, go to Start > All Programs > Cypress > ClockWizard 2.1.  

The workspace files are located in the Workspace folders. The four workspaces available are: 

 CY3676_LVPECL_3p3_156p25.cpj 
 CY3676_LVDS_2p5_50.cpj 

 CY3676_HCSL_2p5_100.cpj 

 CY3676_HCSL_1p8_156p25.cpj 

4. Select the File menu in ClockWizard 2.1, select Open workspace, browse the required workspace file with a .cpj 
extension, and then click Open. Each Workspace file can contain multiple projects. 

5. Click Configure, as shown in Figure 3-6. 

6. Click the Generate button. This will generate the JEDEC file for the configuration selected. The various configuration 

parameters appear on the right panel of the block diagram in the tabbed interface. For more information on configuration 
parameters, refer to the ClockWizard 2.1 User Guide located in Help > User guide of the ClockWizard 2.1 software.  

Figure 3-6. Generating a Configuration Profile using ClockWizard 2.1  

 
 

7. Click Results to view the results generated from this configuration as shown in Figure 3-7. 
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Figure 3-7. View Results Generated from the Configuration Profile using ClockWizard 2.1 

 

8. To program the CY29412 device, select Program in the left navigation pane, as shown in Figure 3-8. Choose the 
appropriate device in the Select Device (I2C Master) drop-down list prior to programming, and then click the Functional 
Program button. This will program the device directly from ClockWizard. LED1 blinks to indicate that the device is being 

programmed. 

For more information, refer to the ClockWizard 2.1 User Guide located in Help > User guide of the ClockWizard 2.1 

software. 

Figure 3-8. Programming Configuration Profile using ClockWizard 2.1 
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9. Executing the Functional Program operation will download the device configuration to the volatile memory. The required 

output will appear on the oscilloscope. 

10. After functional programming the frequency values of the current .cpj are displayed in the Profile 0 (MHz) field (see 
Figure 3-9). You can change the frequency in this field. To make the changes effective, click Large change update. The 

expected output frequency will appear on the oscilloscope. 

Note: Large change programming refers to the case where the frequency is changing more than ±500 ppm. 

Figure 3-9. Evaluation of Other Frequencies through Large Change Update 

 

11. If you want to change the frequency less than ±500 ppm, fill in the desired ppm in the Small change (ppm) field, and 
click on Small change update. An example is shown in Figure 3-10. 

Figure 3-10. Evaluation of Other Frequencies through Small Change Update 
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3.6 eFuse Programming of the CY29412 

After functional programming and evaluation of different clock configurations, the user may choose to write the configuration 
to the non-volatile memory section of the device. The non-volatile memory of the CY29412 is a one-time programmable (OTP) 
eFuse. Any configuration after functional evaluation can permanently be written to the eFuse of the device. See Figure 3-11 
for the programming procedure. 

Configure the device supply to 2.5 V before starting the eFuse programming. Table 4-2 provides the hardware configuration 
(J13 settings) of CY3676 for setting the device supply to 2.5 V. 

Figure 3-11. eFuse Programming using ClockWizard 2.1 

 
 

CAUTION 

Evaluate the configuration via functional programming prior to writing a configuration to the 
eFuse. The configuration cannot be modified or erased once it is written to the eFuse. 

The CY29412 supply must be set to 2.5 V for eFuse programming. Setting the CY29412 supply to 
any other voltage during eFuse programming will cause potential damage of the device. 

 

After the device is eFuse programmed, the user can change the output frequency through the following ways. Note that these 
changes will revert after a power cycle. 

 Large change programming: Large change programming refers to the case where the frequency is changing more than 
±500 ppm. Enter the desired frequency in the Profile 0 (MHz) field, and click on Large change update. The device will 
recalibrate and reconfigure the internal circuit and the output will change to the desired frequency. 

 Small change programming: Small change programming refers to the case where the frequency is changing less than 
±500 ppm. Enter the desired ppm in the Small change (ppm) field, and click on Small change update. The device will 
recalibrate and reconfigure the internal circuit and the output will change to the desired frequency. 
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CAUTION 

It is recommended that you do not perform any Large change programming operation while 
performing Small change programming evaluation. In addition, you should not perform multiple 
Small change programming operations while evaluating Small change programming.  

Follow one of these prior to performing Small change programming: 

 Click the Functional Program button if the device is not eFuse-programmed. 

 Apply power cycle if the device is eFuse programmed. 

 

3.7 Custom Profile Generation 

ClockWizard 2.1 should be used to generate custom configuration profiles. For details on how to create custom profiles, refer 
to the ClockWizard 2.1 User Guide located in Help > User guide of the ClockWizard 2.1 software. 

To understand the output termination settings of different output standards (for example: LVPECL, HCSL, LVDS, or CML), 
refer to the A.1. Termination Settings of Differential Clock Outputs section. 
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4 Hardware 

 

4.1 Board Overview 

The CY3676 EVK is used for evaluating the CY29412 device. 

Following are the key features of the CY3676 EVK: 

 Powered from a USB port 

 Jumper to configure on-board LDO output 

 Jumper to short or isolate external connection for termination settings 

Figure 4-1 illustrates the CY3676 EVK with a markup of the on-board components.  

  

Figure 4-1. CY3676 EVK On-board Components 

 

 

Note: * Components are on the bottom-side of the Evaluation Board. 
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Table 4-1: CY3676 EVK Onboard Components Description 

Label Name Description 

CY29412FLXI CY29412FLXI is the Cypress clock chip that is evaluated with the CY3676 EVK. 

Main Power Supply Jumper (J1) Short pin 1 and 2 of jumper J1 to power up the CY29412. The core supply and I/O supply are the 
same for the device. 

LDO Settings Jumper (J13) 
Set the J13 jumper settings as per Table 4-2 to set the LDO output voltage. 

Note: The brightness of LED2 will vary depending on the voltage selection. It will be brightest at 
3.3 V and dimmest at 1.8 V. 

USB Mini-B Connector Connect the kit to a PC using the USB Standard-A to Mini-B cable. 

VCXO Input (J2) 

This jumper can be used to evaluate the VCXO operation of the CY29412 device. Vc (voltage at 
J2.1 pin) is by default set to 0 V via a jumper shunt. You can remove the shunt and instead apply 
an external power supply voltage (DC) to pin J2.1 to evaluate the VCXO operation.  

Cypress recommends that you contact our Technical Support team at www.cypress.com/support 
before connecting any external power supply to this jumper. 

Status LED 
This LED (LED1) turns ON after the USB enumeration is completed. This LED blinks during 
programming of the CY29412 device from a PC.  

PSoC 5LP (CY8C5868LTI-LP039) 
On-board PSoC 5LP device that converts the USB data-stream to I2C format to program the 
CY29412 device. 

OE Control (J16) Jumper to set the OE input of the CY29412 to enable or disable the clock output. 

Differential Clock Output 
Connect SMA cables to the SMA connectors (J6 and J7) on one end and to an oscilloscope on the 
other end.  

Termination Jumper (J5) The board has an on-board jumper (J5) to connect and disconnect output termination. 

Power LED This LED (LED2) turns ON when the CY29412 device is powered. 
 

Table 4-2: J13 Jumper Settings 

J13 Settings LDO Output Voltage (Supply of CY29412) 

Short pin 1 and 2 2.5 V 

Short pin 2 and 3 (default) 3.3 V 

Open 1.8 V 

 

CAUTION 

The kit should strictly be operated from a USB supply by connecting to a PC.  

The PCB should not be powered by any external source. Application of an external power source 
to any of the jumper pins or test points will cause potential damage of the PCB. 

To configure the device to a clock standard other than those specified in the example projects, or 
to apply a custom termination voltage, go to our support www.cypress.com/support web page, or 
e-mail at clocks@cypress.com. 

Incorrect application of supply or termination voltage will cause performance degradation of the 
clock output. Prolonged incorrect operation may permanently damage the kit. 

  

http://www.cypress.com/support
http://www.cypress.com/support
mailto:clocks@cypress.com
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4.2 Board Details 

4.2.1 Default Jumper Settings 

The CY3676 EVK comes with default jumper settings that set the I/O and core supply voltages as 3.3 V.  

Table 4-3 lists the default jumper settings. 

Table 4-3: Default Jumper Settings on the Kit 

Jumper Default Settings Selection 

J1 Pin 1 and 2 are shorted Power on CY29412. 

J2 Pin 1 and 2 are shorted VCXO input set to 0 V. 

J5 Pin 1 and 2 are shorted CY29412 output termination voltage set to 0 V through the 50 Ω termination resistors. 

J13 Pin 2 and 3 are shorted 3.3 V selected for CY29412. 

J16 Pin 2 and 3 are shorted OE pin set to 0 V (logic ‘0’). 

4.2.2 Power Settings 

The only power option of this EVK is 5V that comes from a USB port. The device has the same core and I/O supply voltage. 
The supply voltage of the device can be selected from on-board generated supplies of 1.8 V, 2.5 V, or 3.3 V.  

Table 4-2 lists the hardware settings required for power selection.  

CAUTION 

The J13 selection must match with the software configuration of the supply voltage. Mismatch 
between the J13 setting and ClockWizard 2.1 setting may cause incorrect output or reliability 
problems with the device. 

4.2.3 Functional Programming  

The board should be connected to a PC through a USB connector to configure and program the device. Refer to the CY3676 
EVK USB Connection section to learn how to connect the kit to a PC.  

Figure 4-2 illustrates the programming section of the kit. 

Figure 4-2. Programming the CY29412 Device 

 
The USB interface provides a 5 V power supply. The PSoC 5LP converts the JEDEC profiles into an I2C-compatible format, 
which is then loaded into the CY29412 clock device.  

Note: During functional programming, set the power supply of the CY29412 device (hardware settings) the same as in the 

ClockWizard 2.1 configuration (software settings). Table 4-2 provides the supply settings for CY29412. During eFuse 
programming, set the power supply of the CY29412 to 2.5V. 

The Example Projects section provides the examples projects (.cpj files) created in ClockWizard 2.1. 
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4.2.4 LED Indicators 

Table 4-4: LED Indicators 

LED Label Indicator Description 

LED1 USB_PWR_LED 
USB Power and 
Status Indicator 

This LED turns ON when the kit is connected to the USB port on a PC using the cable 
provided.  

If this LED does not turn ON, it indicates that the USB enumeration of the kit did not 
happen with the host PC. This LED blinks continuously when the device is being 
programmed through the PSoC 5LP device. 

Note: This LED may glow with low intensity under the following condition:  

The CY29412 supply is disconnected through jumper J1. This low-intensity LED glow 
may be misleading to the user on the status of the USB connection to the board. It 
is, therefore, recommended to avoid this condition during usage of the kit. 

LED2 POWER_LED 
Clock Device 
Power  

This LED turns ON when the core of the CY29412 device is powered. Ensure that a 
jumper shunt is populated or not populated on J13 as per Table 4-2 for proper supply 
of the CY29412.  

The intensity of the LED for 1.8 V is lower when compared to 2.5 V and 3.3 V. 
 

4.3 Evaluating Different I/O Standards Using the CY3676 EVK 

The CY29412 device has one differential clock output pair (CLOCK P and CLOCK N). The onboard components of the 
CY3676 outputs can be configured to different settings for evaluating different clock standards. 

Figure 4-3 and Table 4-5 provide the on-board components related to CY29412 output clocks.  

Figure 4-3. CY3676 Output Termination Settings 

 

 

 

Table 4-5: CY29412 Clock Outputs 

Clock Output CY29412 Pin SMA Connector on CY3676 Resistor to Set Termination (50 ) 

CLOCK P 5 J7 R30 

CLOCK N 4 J6 R31 
 

The CY29412 device supports LVPECL, LVDS, HCSL, and CML differential output types. R30 and R31 are the output 
termination resistors. The termination settings are controlled by the J5 jumper shunt. The typical laboratory setup for the 
evaluation of this kit is shown in Figure 4-4.  

Three on-board 
components J5, R30, and 
R31 set termination of 
CLOCK N and CLOCK P 
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See Table 4-6 to set correct on-board termination option of CLOCK P and CLOCK N. 

Table 4-6: J5 Jumper Settings to Terminate Differential Clock Outputs  

IO Standard J5 Jumper Position Description 

LVPECL, HCSL Short 
CLOCK P and CLOCK N termination voltage set to 0 V through the 50 Ω termination 
resistors. 

LVDS Open 100  differential impedance between the CLOCK P and CLOCK N. 

 

CAUTION 

If the user wants to configure this kit to any other mode, or any other termination setup, it is 
recommended to contact our support through the www.cypress.com/support web page, or e-
mail at clocks@cypress.com. 

J5 should not be powered by any external source. Connection of external power source may 
damage the EVK. 

 

Figure 4-4. CY3676 EVK Connected to Oscilloscope 

 

 

 

http://www.cypress.com/support
mailto:clocks@cypress.com
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5 Example Projects 

 

The CY3676 EVK can be evaluated using example projects that configure the device with different output types and 
frequencies. Each example project corresponds to a particular device configuration. This section provides the configuration 
details of each example project. The configurations generated from the example projects need to be downloaded to the device 
and to be evaluated with on-board termination options. All the example projects are located at: 

<Install_Directory>\CY3676 Evaluation Kit\<version>\Firmware\Example Projects 

The device is not loaded with any default configuration. To evaluate the example projects, follow the steps described in the 
Programming the CY29412 section and refer to the Hardware and Software settings provided in Table 5-1 for programming 
and evaluation.  

Table 5-1: Example Projects Details 

Software Configurations Hardware Settings Evaluation in Oscilloscope 

Example Projects I/O Type VDD 
J13 

Jumper 
Position 

J5 
Jumper 
Position 

Setup 
Output 

Frequency 
(MHz) 

Expected 
Peak-to-

Peak Voltage 
(mV) 

CY3676_LVPECL_3p3_156p25.cpj LVPECL 3.3V 2 and 3 Short Connect SMA 
cables to J6 and 
J7, and connect 
the other ends to 
an oscilloscope. 

156.25 375 to 450 

CY3676_HCSL_2p5_100.cpj HCSL 2.5V 1 and 2 Short 100 375 to 430 

CY3676_LVDS_2p5_50.cpj LVDS 2.5V 1 and 2 Open 50 40 to 50 

CY3676_HCSL_1p8_156p25.cpj HCSL 1.8V Open Short 156.25 340 to 400 

 

The peak-to-peak voltage provided in Table 5-1 will vary with different types of oscilloscope probes, scope-termination, and 
type of coupling used during measurement. These measurements are done using an 8 GHz oscilloscope, SMA cables, 50-Ω 
scope termination, and DC coupling. Sample example project outputs are shown in Figure 5-1 through Figure 5-4.  

Figure 5-1. LVPECL 3.3 V, 156.25 MHz Clock Measured with DC Coupling, 50-Ω Scope Termination  
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Figure 5-2. HCSL 2.5 V, 100 MHz Clock Measured with DC Coupling, 50-Ω Scope Termination 

 

 

Figure 5-3. LVDS 2.5 V, 50 MHz Clock Measured with DC Coupling, 50-Ω Scope Termination 
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Figure 5-4. HCSL 1.8 V, 156.25 MHz Clock Measured with DC Coupling, 50-Ω Scope Termination 

 

 

The example projects provide instruction guidelines for the three I/O standards (HCSL, LVPECL, and LVDS). Other than 
these I/O standards, the CY29412 supports other standards such as CML and LVPECL2. Evaluation of these two standards 
need additional laboratory setup and oscilloscope adjustments. Cypress recommends that you contact Cypress Technical 
Support through www.cypress.com/support web page, or e-mail at clocks@cypress.com if you are evaluating CML, or 
LVPECL2 I/O standard or want to use different coupling, or any other termination voltage that is not part of these example 
projects. 

Any of the four example projects provided in this document, or a project created by the user can be permanently programmed 
to the eFuse section of the device. Refer to the eFuse Programming of the CY29412 section for required guidelines on using 
this feature. 

http://www.cypress.com/support
mailto:clocks@cypress.com
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A.  Appendix 

 

A.1. Termination Settings of Differential Clock Outputs 

The CY29412 device supports four high-speed differential I/O standards.  

Figure A-1 illustrates industry standard termination techniques for reference.  

Figure A-1. Recommended Termination Scheme for DC/AC Measurements

 

The desired output measurement can be done using an SMA cable connected to an oscilloscope. SMA offers an extra 50  
to the oscilloscope ground, which should be taken into account while doing measurements. This kit does not have any on-
board series termination or AC coupling options. Cypress recommends contacting Cypress Technical Support through 
www.cypress.com/support web page, or e-mail at clocks@cypress.com, if you want to evaluate any output with series 
termination or with AC coupling.  

 

http://www.cypress.com/support
mailto:clocks@cypress.com
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A.2. Schematics 

Figure A-2. Sheet 1 – Block Diagram  
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Figure A-3. Sheet 2 – Power Supply Design and LED Indicators  
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Figure A-4. Controller Schematics 
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Figure A-5. Schematics – CY29412 
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A.3. Fabrication Drawing 

Figure A-6. Fabrication Drawing 

 

 

 

 

 

 

 

 

 

 

 



 Appendix 

CY3676 Evaluation Kit User Guide, Doc. No. 002-11165 Rev. *A 35 

A.4. Bill of Materials 

Table A-1. Bill of Materials 

Item Quantity Reference Value Description Manufacturer 
Manufacturing  

Part Number 

1 1 C6 0.01 UF 
CAP CER 10000PF 50V 10% 
X7R 0603 

Murata Electronics  GRM188R71H103KA01D 

2 2 C7,C10 4.7uF 
CAP CER 4.7UF 6.3V X5R 
0603 

Murata Electronics GRM188R60J475KE19D 

3 15 

C8,C9,C27,C38,C41,
C46,C49,C53,C54,C5
5,C56,C57,C66,C67,
C68 

0.1uF 
CAP CER 0.1UF 50V Y5V 
0603 

Yageo CC0603ZRY5V9BB104 

4 1 C26 2200pF 
CAP CER 2200PF 50V NP0 
0603 

Murata Electronics  GRM1885C1H222JA01D 

5 9 
C30,C34,C39,C40,C5
0,C51,C52,C58,C59 

1UF 
CAP CER 1UF 25V 10% X5R 
0603 

Taiyo Yuden TMK107BJ105KA-T 

6 1 F1 
PTC RESETABLE 
FUSE 

PTC RESETTABLE .50A 15V 
1812 

Bourns Inc. MF-MSMF050-2 

7 3 J1, J13, J16 JUMPER 
CONN HEADR BRKWAY .100 
03POS STR 

TE Connectivity AMP 
Connectors 

9-146280-0-03 

8 1 J2 VIN 
CONN HEADR BRKWAY .100 
02POS STR 

TE Connectivity AMP 
Connectors 

9-146280-0-02 

9 1 J5 VCM 
CONN HEADR BRKWAY .100 
02POS STR 

TE Connectivity AMP 
Connectors 

9-146280-0-02 

10 1 J3 USB MINI B MINI USB RCPT R/A DIP 
TE Connectivity AMP 
Connectors 

1734510-1 

11 2 J6,J7 SMA 
CONN SMA JACK 50 OHM EDGE 
MNT 

Cinch Connectivity 
Solutions Johnson 

142-0701-801 

12 1 LED1 LED Green LED GREEN CLEAR 0805 SMD 
Visual 
Communications 
Company - VCC 

CMD17-21VGC/TR8 

13 1 LED2 LED Amber LED AMBER CLEAR 0805 SMD Bivar Inc. SM0805AC 

14 1 L7 
FERRITE 
CHIP 600 
OHM 1.5A 

FERRITE CHIP 600 OHM 
1500MA 1206 

Murata Electronics BLM31PG601SN1L 

15 2 R30,R31 49.9 
RES SMD 49.9 OHM 0.1% 
1/10W 0603 

Panasonic Electronic 
Components 

ERA-3AEB49R9V 

16 2 R1,R211 560 
RES SMD 560 OHM 5% 1/10W 
0603 

Panasonic Electronic 
Components 

ERJ-3GEYJ561V 

17 1 R3 100K 
RES SMD 100K OHM 5% 
1/10W 0603 

Panasonic Electronic 
Components 

ERJ-3GEYJ104V 

18 1 R4 0 
RES SMD 0.0 OHM JUMPER 
1/10W (0402pkg) 

Panasonic Electronic 
Components 

ERJ-2GE0R00X 

19 1 R5 127 
RES SMD 127 OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components 

ERJ-3EKF1270V 

20 3 R16,R226,R228 15K 
RES SMD 15K OHM 5% 1/10W 
0603 

Panasonic Electronic 
Components 

ERJ-3GEYJ153V 

21 2 R17,R18 22 
RES SMD 22 OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components 

ERJ-3EKF22R0V 

22 3 R20,R21,R227 30K 
RES SMD 30K OHM 5% 1/10W 
0603 

Panasonic Electronic 
Components 

ERJ-3GEYJ303V 

http://digikey.com/Suppliers/us/Yageo.page?lang=en
http://www.digikey.com/product-detail/en/GRM1885C1H222JA01D/490-1459-2-ND/586951
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Table A-1. Bill of Materials 

Item Quantity Reference Value Description Manufacturer 
Manufacturing  

Part Number 

23 1 R201 10k 
RES SMD 10K OHM 1% 1/10W 
0603 

Yageo RC0603FR-0710KL 

24 1 R202 22.6K 
RES SMD 22.6K OHM 1% 
1/10W 0603 

Yageo RC0603FR-0722K6L 

25 1 R203 8.25K 
RES SMD 8.25K OHM 1% 
1/10W 0603 

Yageo RC0603FR-078K25L 

26 1 R204 18k 
RES SMD 18K OHM 1% 1/10W 
0603 

Yageo RC0603FR-0718KL 

27 7 
R206,R213,R214,R22
3,R224,R229,R230 

0 ohm 
RES SMD 0.0 OHM JUMPER 
1/10W 

Panasonic Electronic 
Components 

ERJ-3GEY0R00V 

28 2 R217,R218 1K 
RES SMD 1K OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components 

ERJ-3EKF1001V 

29 1 U1 CY29412FLXI Clock generator, LCC package Cypress CY29412FLXI 

30 1 U7 
CY8C5868LTI
-LP039 
QFN68 

CY8C5868LTI-LP039 QFN68 Cypress CY8C5868LTI-LP039 

31 1 U8 MIC5301 
IC REG LDO ADJ 0.15A 
TSOT23-5 

Microchip Technology MIC5301YD5-TR  

32 1 U10 
PUSBM12VX
4-TL,115 

TVS DIODE 5.5VWM 12VC 
6HXSON 

NXP Semiconductors PUSBM12VX4-TL,115 

Special Jumper Installation Instructions 

33 1 J1 
Install jumper 
across pins 1 
and 2  

HW, CONN, Rectangular, MINI 
JUMPER, 6.5mm, CLOSE 
TYPE, BLACK, NICKEL 

Sullins Connector 
Solutions 

STC02SYAN 

34 1 J2 
Install jumper 
across pins 1 
and 2  

HW, CONN, Rectangular, MINI 
JUMPER, 6.5mm, CLOSE 
TYPE, BLACK, NICKEL 

Sullins Connector 
Solutions 

STC02SYAN 

35 1 J5 
Install jumper 
across pins 1 
and 2  

HW, CONN, Rectangular, MINI 
JUMPER, 6.5mm, CLOSE 
TYPE, BLACK, NICKEL 

Sullins Connector 
Solutions 

STC02SYAN 

36 1 J13 
Install jumper 
across pins 2 
and 3  

HW, CONN, Rectangular, MINI 
JUMPER, 6.5mm, CLOSE 
TYPE, BLACK, NICKEL 

Sullins Connector 
Solutions 

STC02SYAN 

37 1 J16 
Install jumper 
across pins 2 
and 3  

HW, CONN, Rectangular, MINI 
JUMPER, 6.5mm, CLOSE 
TYPE, BLACK, NICKEL 

Sullins Connector 
Solutions 

STC02SYAN 

Labels 

38 1 N/A N/A 

LBL, PCA Label, Vendor Code, 
Datecode, Serial Number 121-
60307-01 Rev 03 
(YYWWVVXXXXX) 

Cypress 
Semiconductor 

  

No Load Components 

39 3 C62,C63,C70 1UF 
CAP CER 1UF 25V 10% X5R 
0603 

Taiyo Yuden TMK107BJ105KA-T 
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Table A-1. Bill of Materials 

Item Quantity Reference Value Description Manufacturer 
Manufacturing  

Part Number 

40 1 C5 10UF 
CAP TANT 10UF 16V 10% 
1206 

AVX Corporation TAJA106K016R 

41 2 C31,C35 33uF 
CAP TANT 33UF 6.3V 20% 
1206 

Rohm Semiconductor TCA0J336M8R 

42 1 C33 4.7uF 
CAP CER 4.7UF 6.3V X5R 
0603 

Murata Electronics  GRM188R60J475KE19D 

43 1 H7 2 Pin Header TE_640456-2 (2-pin Header) 
TE Connectivity AMP 
Connectors 

640456-2 

44 1 J4 I2C HEADER 
CONN HEADER 5POS .100 
VERT TIN 

Molex, LLC 22-23-2051 

45 1 L8 
FERRITE 
CHIP 600 
OHM 1.5A 

FERRITE CHIP 600 OHM 
1500MA 1206 

Murata Electronics BLM31PG601SN1L 

46 5 
R14,R15,R216,R210,
R225 

0 ohm 
RES SMD 0.0 OHM JUMPER 
1/10W 

Panasonic Electronic 
Components 

ERJ-3GEY0R00V 

47 1 R19 15K 
RES SMD 15K OHM 5% 1/10W 
0603 

Panasonic Electronic 
Components 

ERJ-3GEYJ153V 

48 1 R208 6.04K 
RES SMD 6.04K OHM 1% 
1/10W 0603 

Yageo RC0603FR-076K04L 

49 1 R207 10k 
RES SMD 10K OHM 1% 1/10W 
0603 

Yageo RC0603FR-0710KL 

50 1 U9 MIC5301 
IC REG LDO ADJ 0.15A 
TSOT23-5 

Microchip Technology MIC5301YD5-TR  

51 8 
TP13,TP14,TP15,TP3
1,TP34,TP35,TP36,T
P37 

BLACK 
TEST POINT 43 HOLE 65 
PLATED BLACK 

Keystone Electronics 5001 
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Revision History 

 

Document Revision History 

Document Title: CY3676 Evaluation Kit User Guide 

Document Number: 002-11165 

Revision Issue Date 
Origin of 

Change 
Description of Change 

** 06/30/2016 TAVA Initial version of the kit guide. 

*A 12/08/2016 TAVA 

Updated Theory of Operation, Programming the CY29412, and Functional Programming. 

Updated Figure 3-1, Figure 3-6 through Figure 3-11, Figure A-2, Figure A-3, Figure A-4, and 
Figure A-5. 

Updated Table 5-1. 

Added Figure 3-10 and Figure 5-1 through Figure 5-4. 

Updated the table description for Item 38 in Table A-1. 

Updated Copyright. 
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